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This tutorial will offer you some advice on how to use Microsoft 
Word, Photoshop Elements, and Adobe Acrobat to prepare an 
optimized digital edition PDF book. 

There are two ways to produce a digital edition PDF presented in 
this tutorial. One way will use Word to directly export a PDF at a 
resolution appropriate for viewing on computers and devices. The 
other will use Acrobat Pro to optimize an existing high-resolution PDF. 

If you do not have Acrobat Pro and wish to test this process, you can 
download a trial version from the Adobe website: www.adobe.com.

The Tutorial is Broken up into Sections:
1. Setting up your Word document

2. Adding Cover Images and Setting Up Pagination

3. Adding Bookmarks

4. Adding Hyperlinks

5. Compressing your Word document before Export as a PDF

6. �Exporting�your�Word�file�as�a�PDF�ebook

7. Optimizing a high-resolution PDF using Acrobat Pro

8. Tips and Things to Remember

9. What do I do Next?

10. I Need More Help!

What do I Need?
This tutorial will have you use Microsoft Word to create your 
content and export it as a PDF digital edition ebook, and 
Photoshop�Elements�to�create�your�cover�file.�

You may also choose to use Adobe Acrobat Pro for optimizing 
a�high-resolution�PDF�file,�rather�than�a�direct�Microsoft�Word�
export.�Acrobat�Pro’s�profile�for�optimization�is�more�complete�but�
it is entirely optional.

The screenshots shown in the tutorial use Microsoft Word 2007 
and  2010 for PC, Microsoft Word 2011 for Mac, and Adobe 
Acrobat 9 and X for Mac. If you are using different versions of 
the software some of the instructions and screenshots will be 
slightly�different,�but�hopefully�you�can�find�the�right�feature�in�your�
software version.

How do I Get This Software?
You�can�purchase�Word�as�a�part�of�the�Microsoft�Office�suite.�
Microsoft�also�offers�a�free�30-day�trial�version�of�Office�at�the�time�
of this writing: http://us20.trymicrosoftoffice.com/default.aspx

If you prefer not to use Microsoft Word, then you can purchase  
Mac�Pages�or�try�the�Open�Office�Writer�program,�which�is�free�
and is available at: http://www.openoffice.org/

How to Prepare a Digital Edition PDF Book With Microsoft Word



2

1. Setting up your Word document

For�your�convenience,�we�have�created�a�few�template�files�for�
different standard book sizes to make your layout work easier. You can 
find�these�templates�on�the�the�How do i prepare downlaod 
files for my digital title  link under digital titles in the 
pUBlisHer Knowledge Base section of your Publish Menu.
Setting�up�your�file�is�nearly�identical�to�setting�up�a�book�for�print�
but�the�specifications�are�much�looser.�If�you�plan�to�produce�both�
print�and�digital�editions,�you�should�set�up�your�book�files�to�print�
specs�and�then�produce�a�digital�book�from�the�same�files.�
(For�more�information�about�the�mechanics�of�setting�up�your�Word�file,�
e.g., importing and styling text and inserting art, see the DriveThru tutorial 
for Microsoft Word in the Print Templates and Tutorials of the publisher 
Knowledge Base, under title management/ Book printing.)

2. Adding Cover Images and  
Setting Up Pagination

Your�file�should�include�the�front�and�back�covers�at�the�front�of�
the document and have pagination that sets those pages off from 
the rest of the book. First add two blank pages at the beginning of 
your document. Then insert your cover images on those pages. 

If�you�are�preparing�your�file�for�an�additional�print�edition,�you�can�
insert the cover images you built for your print-ready PDF. Follow 
the instructions for Inserting Art into your Word document as 
outlined in the Drive Thru tutorial found in the Print Templates and 
Tutorials of the publisher Knowledge Base, under Microsoft Word.

If you are not preparing your book for an additonal print edition, 
you can either build your covers in an image editor like Photoshop 
Elements and then insert them, or build a custom cover using 
Microsoft Word’s Cover function, under the Insert Pages tools, which 
is found under the Document Elements tab, if it’s available in the 
version of Micrsoft Word that you are using.

Once you have inserted your covers, you will want to change the 
pagination of those pages to Roman numerals (i, ii). This is a good 
idea to do because the cover pages won’t goof up the interior book 
block pagination. Those page numbers will still reference the Table 
of Contents.

First, with your text cursor placed somewhere on the front cover 
page, pull down the Insert menu from the top of your screen and 
select Page Numbers. The Page Numbers dialog box will open. 
Set your position and alignment, then click the Format  button at 
the bottom. In the Page Number Format dialog box, pull down 
the Number format menu and select the Roman numerals (i, ii, 
iii, iv, etc.) Then, under the Page numbering details, make sure 
the number in the Start�field�is�“i”.

This changes all of the page numbers in your document to 
Roman numerals. Now you will need to force a Section Start 
and reformat the page numbers after the covers.
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With� your� text� cursor� in� place� before� the� first� interior� page� of� your�
book, pull down the Insert menu again from the top of your screen and 
choose Break. The Break contextual menu will open. Choose Section 
break (Next Page). A new section will be created and a page inserted.

2. Adding Cover Images and Setting Up Pagination (continued)

Place your cursor at 
the beginning of your 
intended� first� page,� then�
pull down the Insert 
menu from the top of 
your screen and select 
Page Numbers again. 
The Page Numbers 
dialog box will open. 
Set the position and 
alignment details of the page numbers for your book body content, 
then click the Format button at the bottom of the box.

In the Page Number Format 
dialog box, pull down the Number 
format menu and select the 
Arabic numerals (1, 2, 3, 4, etc.) 
Then, under the Page numbering 
details, make sure the number in 
the Start�field�is�“1”.�Click�OK.

Now the rest of your document 
has been repaginated. Make sure 
to check your Table of Contents 
against�the�first�page�of�every�
chapter to make sure your page 
numbers cross-reference correctly.
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The Bookmark dialog 
box will open.

In the dialog box, 
click the Add 
button. If you select 
the Location radio 
button in the Sort 
By: details at the 
bottom of the box, 
you bookmarks will 
be sorted in order 
as they occur in the 
document.

3. Adding Bookmarks

To make navigating through a large PDF book easier, 
bookmarks can be made in your Microsoft Word document, 
which�can�be�exported�and�used�in�your�final�PDF�digital�
edition. A good use of bookmarking is to place one at the 
first�page�of�every�chapter�in�your�book,�so�readers�can�jump�
straight to the chapter of the book where they last left it.

You will need to add bookmarks before you begin hyperlinking your 
Table of Contents to your chapter starts.

First, navigate to the text in your document that you would like 
to bookmark, and select it with your cursor. Then, go to the 
Links options and select the Bookmark icon. 

Continue doing this to bookmark the important target spots in 
your book.

Remember�to�test�the�bookmarks�in�your�final�exported�PDF�to�make�
sure the page destinations you have established are all correct.
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4. Adding Hyperlinks

The Insert Hyperlink dialog box will open.

In this dialog box, click to select the Place in This Document icon at 
the left under the Link to: list. At the top in the Text to display�field,�
update the name of your displayed hyperlink text as necessary. 
Then, under the Select a place in this document list, select the 
correct target Bookmark that corresponds with your source Table of 
Contents entry. Click OK.

In some digital books, you may want to add links between pages 
that occur in your document, such as links from the entries in your 
Table of Contents to your chapter starts, or links to destinations 
outside your document, such as a web URL. In Microsoft Word, you 
can dictate links from selected text as well as pictures that have 
been inserted in your document.

If you choose to add interactivity to your digital edition, make sure to 
test�each�created�link�in�your�final�PDF�after�export.�

Adding links between pages
First, navigate to the text or image in your document, and select 
it with your cursor. Then, go to the Links options and select the 
Hyperlink icon. You can also right-click with your text or image 
selected to bring up a contextual menu.
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In this dialog box, click to select the Existing File or Web Page icon 
at the left under the Link to: list. At the top in the Text to display 
field,�update�the�text�as�necessary.�Then,�in�the�Address:�field�at�
the bottom of the box, paste the web URL or manually type it. Don’t 
forget�to�include�the�“http://”�in�front�of�the�address.�Click�OK.

Now the selected source text will be displayed with an underline 
and in a different color from the rest of your body text. After you 
have added your external hyperlink to your source text, you can 
easily test it by placing your cursor somewhere in the link text, right-
clicking your mouse to expand a contextual menu, and selecting the 
Open Hyperlink option. When you click to select this, it should open 
a�web�browser�window�and�load�the�web�URL�you�have�specified.

Adding links to destinations outside your document
To set an external 
destination, such as 
a web link, begin the 
same way. Select the 
text you wish to use 
as your source, then 
right-click and select 
Hyperlink from the 
contextual menu, or 
select the Hyperlink 
icon from the Links 
options at the top of 
your screen.

4. Adding Hyperlinks (continued)

The Insert Hyperlink dialog box will open.
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There�isn’t�really�a�lot�of�flexibility�when�it�comes�to�Microsoft�Word�
and PDF export settings. To prepare your document for a lower 
resolution export, one that is more appropriate for web and device 
viewing,�you�will�have�to�reduce�the�file�size�in�one�of�two�ways�
before export. The method you use will depend on which version 
of Microsoft Word you are using. 

In newer versions of Word, you can pull down the File menu, then 
select Reduce File Size... A dialog box will open. There you will select 
Best for viewing on screen as your preferred picture quality. Make 
sure to check the box next to Remove cropped picture regions.

5. Compressing your Word document before Export as a PDF

Change resolution, select the radio button for Print. (Print should 
actually be 300 dpi, so this setting isn’t accurate at 200 dpi. We will 
use it here because the only other option is the Web/Screen setting 
at 96 dpi, which is much lower than the specs for image quality we 
prefer for books.) Make sure to check the Compress pictures and 
Delete cropped areas of pictures options in the dialog box. Click OK. 

Microsoft Word 2011

In other versions of Word, you can right-click on any image in your 
book, which opens a contextual menu. Select Format Picture from 
that menu. The Format Picture dialog box will open. Ignore all the 
details, and go straight to the Compress button at the bottom of 
the box and click it.

Next, the Compress Pictures dialog box will open. Under Apply 
To, select the radio button next to All pictures in document. Under 
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That’s�it!�Word�will�process�your�file�and�save�it�as�an�optimized�
PDF�file.�
It’s best practice to check your PDF after it has been exported, 
to make sure all your bookmarks and links work and are on the 
correct targets, and that no other errors have occured on export. 
Once you proof your PDF for any corrections (and apply any 
corrections, as necessary), then you’re really done!

Now that you’ve completed setting up your book for print, exporting 
it as a digital PDF ebook is easy! There are three ways to make an 
optimized�digital�edition�PDF�from�your�file:
1. ��Export�a�PDF�directly�from�Word,�adjusting�your�PDF�export�

settings to make them appropriate for viewing on a computer, a 
tablet or other mobile device.  
(This method will be covered in the following pages.)

2.  Use a high-resolution PDF and optimize it in Acrobat Pro using 
the Preflight�Print�Production�Tool.�When�you�open�the�Preflight�
tool, make sure to choose the Online Publishing (optimize for 
quality)�profile�under�the�Digital Printing and Online Publishing 
profile�options.� 
(This method will also be covered in the following pages.)

3. �Export�a�postscript�file�from�Word�or�Acrobat�Pro�for�processing�
in�Acrobat�Distiller.�This�method�uses�a�custom�profile�setting,�
called�a�.joboption�file,�made�in�Distiller. 
(Although�this�method�tends�to�make�more�stable�files�that�are�
less prone to errors, it will not be covered here.) Finally, you are 
ready to export your digital edition PDF!

From�the�menu�at�the�top�of�your�screen,�find�and�click�Save or 
Save As. It may be in a pull-down menu, or it may be an icon 
depending on the version of Word that you are using. The Save as 
dialog box will open. 
Navigate to the location on your hard drive you would like to save 
your�new�file.�Change�the�name�slightly�so�you�don’t�overwrite�any�
previously made, high-resolution copies of the same document. In 
the Save as File Type drop-down menu, select PDF�files�(*.PDF). 
Click the Save button.
You may get a Warning dialog box 
about�the�compression�you�just�inposed�
lowering the quality of your images. 
This�is�fine,�so�ignore�it�and�click�Apply.

6. Exporting your Word document as a PDF ebook
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7. Optimizing a high-resolution PDF using Acrobat Pro

The Preflight dialog box will open. 
Expand� the� profiles� for� Digital 
printing and online publishing, and 
choose Online publishing (optimize 
for quality). Then click the Analyze 
and� fix button at the bottom right-
hand corner of the box.

A�dialog�box�will�open,�prompting�you�to�save�the�file.�Make�sure�to�
change�your�file�name�slightly�so�as�not�to�overwrite�your�high-resolution�
print�PDF�file.�Click�Save.�Then�the�Preflight�process�will�begin.

Once� Preflighting� is� done,� the�
Preflight dialog box will list a report 
of�tasks�completed.�If�your�file�was�
successfully processed, a green 
check mark will appear in the top 
left-hand corner of the window. If 
it failed, a red X will appear in the 
same place. On failure, you can 
poke through the process report in 
the dialog box to see what elements 
failed,� and� then� go� back� and� fix�
those elements before trying to 
Preflight�again.

Using the Preflight Print Production tool 
You can take a high-resolution PDF and process it for web and device 
viewing by using this tool in the full version of Adobe Acrobat. Again, 
your�file�should�include�the�front�and�back�covers�at�the�front�of�the�
document and have pagination that sets those pages off from the rest 
of the book.

Open�your�PDF�file� in�Adobe�Acrobat.�Depending�on�the�version�of�
Acrobat that you are using, you can either expand the Tools pane 
from the upper right hand corner of your window, expand the Print 
Production tools and navigate down to Preflight (Version X) or pull 
down the Advanced menu from the application bar, and navigate down 
to Preflight�(Versions�9�and�earlier).

Acrobat X Acrobat 9 and earlier

To learn more about using Adobe Acrobat for bookmarking and 
hyperlinking, refer to DriveThru’s Quick Specs for Digital Books.
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Specifications
Although exporting your PDF using the methods provided will 
take�care�of�most�of�the�specifications�required�of�a�digital�PDF�
ebook, there are a few things that are important enough to bring 
to your attention again. These points are listed in DriveThru’s 
Quick specs document and Checklist for digital Books, both 
of which can be found on the How do i prepare downlaod 
files for my digital title  link under digital titles in the 
pUBlisHer Knowledge Base section of your Publish Menu.

•�  DO NOT use JPEG2000 compression in any linked or   
� embedded�JPEG�art�files,�even�if�it�reduces�your�file�size.� 
 Apple’s iPad and iPhone cannot display images using  
 JPEG2000 compression.

•� DO NOT�use�PDF/A�profile�compliance�for�your�exported�PDF.

•�  DO NOT use transparency in your document or images.  
  Apple’s iPad and iPhone also have problems displaying 

PDFs with transparency attributes.

•�  DO NOT lock or use security settings in your exported PDF.  
 This means imposing password protection as well as   
 turning off the ability to copy/paste or print from the PDF.  
  These options can be managed under the File Security 

settings in your Product File information on the DriveThru 
site when you upload your book. Any security settings 
imposed on your uploaded digital edition will cause errors 
during the automatic watermarking process at the point of 
customer check-out.

8. Tips and Things to Remember 9. What do I do next?

Once�you�have�finished�producing�and�testing�your�digital�PDF�
edition, you’re ready to upload! Log into your account on site and 
go to the title management section of your Publisher Menu 
and use the set Up a new title tool. 

If�you�have�any�questions�about�how�to�proceed�with�filling�out�this�
form, see the set Up a new title & edit a title link under 
digital titles in the pUBlisHer Knowledge Base section of 
your�Publish�Menu.�You�will�find�more�information�there�to�assist�you.

After a successful upload, you can choose to activate your title for 
live sale! How exciting!

10. I Need More Help!

Your publisher service rep is not really an expert on digital 
layout, so chances are slim that he or she will be able to answer 
questions not answered in this tutorial. However, please do email 
us�your�questions�anyway�so�we�can�help�find�an�answer�if�we�
can and also so that we can improve this tutorial so it answers 
more questions for everyone.
You�can�also�find�people�with�professional�skills�in�digital�layout�
and�contract�them�to�create�your�files.�The�cost�of�this�work�
depends on how much of the work you do yourself before handing 
it over for layout. We can recommend someone for layout if you 
would like. Please contact Publisher Service for details.
Or�you�can�also�find�freelance�layout�professionals�at�sites�like� 
www.upwork.com.


